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Lesson Objectives

P dse Lok
* Open SPSS Data Documents

* Import Excel and text files using SPSS’s import tools.
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Opening SPSS Data Documents (.sav)

Mamé SA "4
* Open SPSS if you haven't already, and open dﬂa.gg_\_/.
v'Browse for the file if prompted. é:’ O

v'Otherwise, go to Files1@pen>;Patasandsfindsthesfile:

'17' demo.sav [] - IBM S5P55 Statistics Data Editor

Edit View Data Transform  Analyze Graphs Utilities

Import Data ’ Internet Data
General Open & Syntax._.
Fa

&= Output. .

1 Open Restore Point. .. ®
Workbook

Bl Close Ctrl+F4

& Script...

.- i T =
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* If an Output Window pops up, minimize. it for now. D
* You should now have your SPSS Data Document open.
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’ X L r‘ d.
5 *Output1 [Dacument1] - IBM SPSS Statistics Viewer E ] e U » . e

File Edit Wiew Data Transform Insert Format Analyze Graphs Utilities Extensions Window Help : I
i i W L O = e e N u,k ut
HE Q &) Ilj v i A = » B[ O f
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IBM SPSS Statistics Processor is ready 2€ Unicode:OM Classic



Importing Excel Files

Nameg
* Before importing our Excel file, let’s take a look at the file in MS Excel.

A B C D F G
Marital Income Job
O .Age Gender Stitu_s .ﬁddress Category Category
2 55 f 1 12 3.00 3
3 56 M 0 29 4.00 3
4 28| f bho answer] 9 2.00 1
5 24 m 1 4 2.00 1
6 25| m Ino answer] 2 1.00 2
7 45 m 0 9 4.00 2
8 44 m /1 17 4.00 3
9 46 m O answer 20 4.00 3
10 41 m O answer 10 2.00 2
11 29 f O answer 4 1.00 2
12 34 m 0 0 4 .00 2
13 55 f 0 17 3.00 1
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* There are some common problems that may appear in data files.
v'Leading and trailing spaces o5 L S
v'Empty data cells AV v
v'Data cells with invalid values ") o<e® _c.s =
* SPSS provides tools to deal with these'problems when importing

data. ,“E-/’ W ] A SR~ aled _'y,\ o SFSs
v'Close your MS Excel window and go back to SPSS.

v Go to >@and find-data.xlsx



¥8 demo.sav [DataSet?] - IBM SP5SS Statistics Data Editor
Edit View Data  Transform  Analyze Graphs Utilities Extensions Windo

WA BE

Open

Import Data

T —

ool General Open

Database - I

= CSV Data. . -
Open Hestore Point. .. .
3 Op Text Data._ - PV
Bl Close Ctrl+F4 u}tt
o SAS
B Save S Stata...
= As__.
s dBase. .
] Save All Dat
bH sve Al LEtE Lotus._.
S Rest Puoint. ..
H@ Save Restore Poin SYLK. ..
Export >
Cognos TM1._.

@ Mark File Read Only _ _
Cognos Business Intelligence_ ..
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* This will open up an import tool. You’ll have a few options to choose

from, such as whether to remove leading/trailing spaces, whether the

first row contains variable names, and more.

el Reaod Exce=l File

C ol =saerstumotorngeriDownloadsthdaerrmo sl s>

Wivworksheset: Sheet1 1S 207]

FRange:-

- r —
W Read variable mnames from first row of data \)’8 ‘w \ ar _J‘_'b-ﬂﬂ-c‘ “".l
-
v Fercentage of values that determine data twpe: |95 |

Remowve leading spaces from string values

Rermows trailing spaces from string values

= suge arh Sendeaer =5 Plarital Status = Address = IncomeCataegors = JobCateg

1 55 Ll “1 12 .00 3 -~
= 55 r (o] =29 = _ 00 3

3 =28 Ll - 9 2Z_ 00 1

=1 = e -1 =1 = o0 1

= =25 e - = 100 =

5 45 (2] (o] 9 < _00 =

rd 1.4 i “1 17 = _ 00 3

S 15 i _ =0 = 30 = -
<

T

@ Finmnal data twpe 1s based on all data amnd can be differemnt from the previewvw, which is bbased on theae

first 200 data rowvw=s_ The oo j=ewe displaws onlyw the first SO00 colurmns_
@l Faste I I Resat | ICElr‘ll:elI I Help
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* A preview window is provided below to see how the data will look
after the import finishes. The most important setting is Rergentage-of
valuvessthai-determinesdatastype. This will automatically deal with
'r blank and invalid values, replacing them with System Missing. Notice
that, if you turn off this setting, Marital Status becomes a String type

rather than a numerictype, which is not what we want.
..../\_,LU*” ;/_5 J\,J\ (_‘.:\.d\ a..__...z_ \ ,\Q r(y" /\Abe)b\_o

* Once you’re done, d(yjﬁ_gﬁgck your settings and click Q_(
‘ "DLQ-’J\ L.-——-‘F" LV-B_A,U\-/ u_,._é



Importing Text Files (.txt)

* Importing a text file with data is quite similar to importing an Excel
file, but there are more options and settings to take care of. Just like

last time, let’s take a look at our text file before importing.

e
- \ 4
5‘53/))

=

File

Age
55
56
28
24
25
45
a4
a6
41
29
34
55
28
21
55
35
45
21

demo

Edit

2 2 +Hh-Hh3 Hh3 KB 222 2 2

Ln 10, Col 19

+

Gender

iew

Marital Status

no amn

no an

no an

no an
no an

QR

Swer

Swer

Swer

Swer
Swer

[l R v B S R o T o]

+

Yab

72.e8 3.8@0 3
153.00 4.80 3
9 28.e0 2.80
26.80 2.80 1
2 23.e0 1.00
76.80  4.80 2
144.00 4.80 3
2@ 75.88 4.80
1@ Pe.ea 2.\88
4 19.@@ 1.80
89.80 4.80 2
72.e@ 3.80 1
55.e@8  3.@0 1
2e.ee 1.@0 1
283.00 4.00 2
70.e0 3.00 2
48.00 2.00@ 2
37.e0 2.00 1

10054 Unix (LF)

=
[

g}qha-

Address Income-Income1CateEor1y Job Category

1

2

3

2
2

TF-8&

X
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* We can see some of the same problems we encountered in our Excel
file. Leading and trailing spaces, as well as no answer values. In the
text file, the data isn’t aligned with thelr rows elther

* If you mess around with the data, you’ll notice that it’s tgh- :
This’ll help SPSS differentiate the difference between “Income. 7
Category and “Income” + “Category”.

z_‘_, N7 «

_ Ues) b

* Close your text file and go back to SPSS. BEXWISIER
-

* Go to File > Import Data > Text data... and find data.txt.



#2 *Untitled2 [DataSet3] - IBM SPSS Statistics Data Editor

Edit View Data Transform Analyze Graphs Ltilities Extensions Windo

Hew j%% M=

Open

Import Data > Database 2 =
General Open Excel._.

| £ CSV Data. ..
5 Onen Restors ot
Il Close Ctrl+F4 SAS.
H Save Ctrl+5 Stata. .
. Save As.__. dBase. |

¥ Save All Data Lotus. ..
D Save Restore Point._. SYLK. .

Export ? Cognos TIM1__.

Cognos Business Intelligence. ..



Step 1

TR Text Import Wizard - Step 1 of 6

G2H RB40 L B1 285
G0 FA00 B TR Q033
A2 10200 G B 3108
BP0 933117
1740 w0 L

Welcome to the text import wizard!

This wizard will help vou read data from your text file and
specify information about the variables.

CWIgaly o\ Gl s s

Dloes widur text ﬁre match a predefined format?

O Yes Browse
@ Mo!
Text file: CAlsers\motorger\Downloads\demo _txt
0 10 20 30 A0 S0
| I T T O T T T T O T O T T O T T T R N T T T T I T T Y O T T T T T T T T T T I T N O N T O T O TR S N T |
MName| |ng= Fender Marital Status Address Income Incomes Cal*™
2 55 £ 1 12 T2.00 3.00 3
3 SE m ] 25 153.00 4.00 3
4 28 £ no answer g 22.00 2.00 1
5 2.4 = 1 A 2E O 2 AN 1 i
£

= Back Finish Cancel Help




Step 2

* Our data is delimited by tabs, with the first line in the data being our
variable names. We’re also using a period (.) for our decimal symbol.

EE Text Import Wizard - Step 2 of 6

>
T — How are your variables arranged? w C’ 7\ Tﬂh d y‘?‘.‘)” C\w\) Cv:u :—r" r:" -:.l‘_;:h-’:'\-s"‘
A% Gf“de L/ - Wariables are delimited by a specific character (i.e., comma, tab). ¢

O Eixed width - VWariables are aligned in fixed width columns.
- s ID
-
Are variable names included at the top of your file? J b:,"‘-’ﬁ = :,.!: i
—

s AL
—
Line number that contains variable names: - ..
-
Nl Isee)) das<

O Mo

What is the decimal symbol? S | ) | L'/.—": -

=¥ Period

O Comma

Text file: CAUsers\motorgeriDownloads\demo txt

>

Finish Cancel || Help




Step 3 I e |
4
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* The data starts on line 2, with each line representing one participant

(or one case), and we want to import all the cases. You can also
import the fLr.sLX_cases_QLa_candam_p;achn.tage__oﬂhe_daIa

L.a Text Import Wizard - Delimited Step 3 of &

l'a_‘? \_,9 \M 6 ’“{N\ The first case of data begins on which line number? I 2
How are your cases represented?
AR 2 G
J,.ﬁ-f) ——f

@ Each line represents a case I

) A specific number of variables represents a case:

)' ! \ 6\ How many cases do you want to import?

I@}AII of the cases M I
\-3__,—— O The first [0 cases. -#_I'}Ux P —— .l

O A random percentage of the cases (approximate): 10 9% _:vJJ u. \.r- a— |

,w’

Data preview

O 10 20 30 40 50
..........................................................
Mame |Lge Gender Marital Status Address Income Income Cal”™
2 55 £ 1 12 T2.00 3.00 3
3 S & m u} 29 153.00 4.00 3
41 Jz= f no answer ] 25.00 2.00 1|~

Finish Cancel || Help




Step 4

* This is where we can choose our delimiter and get rid of our extra

spaces.

d.'t_, & Text Import Wizard - Delimited Step 4 of 6 o . L Y | (.»-_!_--6:-"'*‘ \ -_-)\ 9 A >

Which delimiters appear between variables? What is the text qualifier?

A Tab ] space @ Mone
[] comma [] semicolon O Single guote
| B[] Other: O Double quote
. Q{J\ :)\" \_,J...‘ Leading and Trailing Spaces O Other:
o © 39 ? kAT Remove l2ading spaces from string values
..:.-(-'UJ | E’Remoge trailing spaces from string values
Data preview
Age Gender Marital St._. Address Income Income C._. Job Cate__.
55 f 1 12 T2.00 3.00 3 ~
56 m 0 29 153.00 4.00 3
28 f no answer 9 28.00 2.00 1
24 m 1 4 26.00 2.00 1
25 m no answer 2 23.00 1.00 2
45 m 0 9 76.00 4.00 2
44 m 1 17 14400 4.00 3
46 m no answer 20 75.00 4.00 3
41 m no answer 10 26.00 2.00 2
29 f no answer 4 19.00 1.00 2
34 m 0 0 89.00 4.00 2
585 f 0 17 T2.00 3.00 1
| 28 m 0 9 55.00 3.00 1 >
| ' :
Finish Cancel | | Help




Step 5

,_//(j)g;\ SLC'e'l gca_b Vo dLﬁJ\;J_ q\o;

* You might have received a warning message regarding invalid variable
names. It’s important to note that there are some limitations to variable
names. et s = s Lesd o Wo

* Variable names can be up to 32 characterslong. o, 32 (LS o

* Variable names can only include alphanumeric characters (letters and
numbers), non-punctuation characters (like a dash- or an underscore _),
and a period {(.). (sl S5 s usd lies

* No spaces are allowed in variable names. BV PR O
* Variable names cannot end with a period (.) or an underscore (_).
* There are some reserved keywords you can’t use as variables, such as AND,

NOT, QR, etc. Cperloi~cfe > 21 2t s
* Variable names must be unigue. _ 5\ eRas s(qeliv

. * e
pl:,j\.’ﬁu Q\%‘;L‘—'—x\



Q Text Import Wizard - Step 5 of 6

Specifications for variable(s) selected in the data preview

Variable name: Original name:

Age Age

Data format:

Automatic "

2 Text Wizard - L
. L~ \ - . 7

Bercent = I- Invalid variable name# for this appli€ation have been found and changed.
Data pr OK

Age . MICUTTE MICUINEG. . JUDGEley. .
85 i K [12 72.00 3.00 (3

bb m 0 29 153.00 4.00 3

28 f no answer |9 28.00 2.00 1

24 m 1 4 26.00 2.00 1

25 m no answer 2 23.00 1.00 2

45 m 0 g9 76.00 4.00 2

44 m 1 17 144.00 4.00 3

46 m no answer 20 75.00 4.00 3

41 m no answer 10 26.00 2.00 2

Finish Cancel Help




Step 6

D Da? Lo (geo oL gS wos Wiyt e
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* Finally, your data is imported. You're given the option to save the file
format as a TextWizard Predefined Format file. This is particularly

useful if you have multiple files to import with the same formattmg

EE Text Import Wizard - Step 6 of 6

TEEH
qHHAL

Data preview

IWEERERRBED

!'"333333'"3'"9

“ou have succe

ssfully defined the format of your text file.

D_}ﬂ_s' P -
||§Ewe As_ ‘ ‘ \} JW

Would vou like to paste the syntax? [liCache data locally

O Yes - _J\ N—-—_

Would you like to save this file format for future use?
O Yes

= Mo

\

& Mo
- * ’Yo :*—L
Press the Finish button to complete the text import wizard. —t \
“ —t
MaritalSt...  Add Income IncomeC_.. JobCateg... - (.1/
1 12 72.00 3.00 3 ~ L}__,UJS 2
0 29 153.00 4.00 3 -
no answer |9 28.00 2.00 1 /
1 4 2600 2.00 1
no answer 2 23.00 1.00 2
0 a 76.00 4.00 2 '/
1 17 144 00 4.00 3
no answer 20 F¥5.00 4.00 3
no answer 10 26.00 2.00 2
no answer 4 19.00 1.00 2
n a A nn B ~
T I |




